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Introduction
The Internet Site Blaster (tm) uses a database format.    Each page of Internet information is 
considered one record, unless you are in the table view, when one record will correspond to one 
line of the table.      The individual text areas on a page where information can be entered are 
known as fields.    The entire collection of records is called a database.

 Each database has its own particular characteristics which, with Internet Site Blaster, are 
described in what is known as the File Definition. An Index organizes the information in one field 
in such a way as to allow rapid access to that field's information.    The Internet Site Blaster can 
have an Index on one or more fields.    If you like, you can make indexes on each of the four fields 
in the database.

The program    ships with an index already assigned to the Description field. 

You will need to create indexes on the other fields as follows: 

After you start the program, go to the File menu and select "Indexes".    You will be shown the 
Indexes dialog box.    Next, highlight the name of one of the fields by clicking on its name on the 
left.    Then select "Add" and this field will be transferred to the right side and an Index will be 
created when you leave this dialog box.    It is recommended to at least create indexes for the 
Description and the Address fields.



Layout

The Icon Bar provides quick access to the most commonly used functions:

The Form View

This is the most commonly used view for entering, viewing, and working with data.    There are 
other views however, which at times can be more useful to you than the form view.    The Form 
View is the only view that allows you to view an image and data on the same screen.    The other 
views popup an image window that must be closed to return to working with data.

Table View

The Table View displays many records at one time for easier viewing of groups of records.    The 
layout of the table view can be modified so that as much or as little of any field shows on the 
screen with the Field Selection icon.    The Table View is also advantageous for using the Group 
Find function.    After you set the search criteria, all of the records that match in the database will 
be displayed in the Table View for you. 

Page View

The Page View displays the fields on a page in a compact format for easy data entry.    Select the 
Add Record icon to start a new page and the Change Record icon to modify existing Internet 
information.    The advantage of this view is that it is not necessary to do any scrolling up and 
down the page to reach all of the fields.

Field Selection

This icon allows you to change the order in which fields are viewed in the Table View and Page 
Views.    This lets you move the other fields, such as the Address Field, to the first column in the 
Table View.    With the Layout command under the Edit menu, you can change the size of the first 
column so that more or less can be seen as desired.

Save Record

When you have added or changed information in the database, you can use this icon to save your 



work.      Any time that you make changes in the database you will be prompted to save the new 
information.

Add Record

To add a new information page, choose this icon to begin entering new Internet data.

Change Record

When information needs to be edited or modified, select this icon to begin entering the desired 
changes in the Table View or Page View. In the Form View, simply click on a field to begin data 
entry.

Delete Record

When you need to destroy a record, then select this icon.    You will be prompted to make certain 
that you want to delete the record.

Registration Benefits

Choose this icon to view the benefits of registration and the bonus programs that come with the 
Registered Version of Internet Site Blaster.

Help

The Help Button to the far right of the icon bar can give you access to this help file from within the 
program.



Navigating

The icon bar along the bottom allows for navigation through the program by use of the mouse.

Although you will find a mouse essential in using the program, there are keyboard methods of 
navigating through the database that allow for rapid movement.

For instance, the left and right arrow keys can take you one record backward or forward in the 
database.    If you hold the left or right arrow key down, then the database will be rapidly scanned 
in the chosen direction, just like the Fast-Forward or Fast-Reverse keys.      The PgUp and PgDn 
keys will also emulate Fast-Forward and Fast-Reverse.    The Home key and the End key will jump 
to the first page and last page of the database, respectively.    If your mouse hand tires easily, the 
keyboard approach to navigating can prove helpful.

Pause

Also on the lower icon bar, the icon with the double bar is present to allow you to pause in the 
process of performing a database operation.    De-select the icon to resume the paused procedure.

Stop

The solid square icon adjacent to the Pause button, allows you to terminate any    database 
operation in progress.

 VCR Controls

The controls for traveling through the database are similar to those seen commonly on a video 
cassette recorder (VCR).    The buttons on either end take you to the beginning or the end of the 
database instantly.    The double arrows pointing to the left take you rapidly through the database 
to the beginning.    The double arrows pointing to the right allow you to scan rapidly to the end of 
the database, similar to Fast-Forward on a VCR.    The single arrows pointing left and right move 
one page, or record, at a time.    The single arrow pointing up is used only in the Table View.



Displaying Internet Information

There are three ways to view Internet information from within the database:

The Form View:

This view is the main view from which you will enter data, perform searches, and move through 
the database.    Both the top icon bar and and bottom icon bar contain all of the basic functions 
you will need for most activities.    The menus allow other, more complicated procedures to be 
performed.    These commands are discussed in the Menu Command Summary.

The Table View:

It is helpful sometimes to be able to view the Internet information in the database in a table format. 
This is true particularly when search criteria are specified and the files matching that criteria are 
collected into one set.    By using the Table View, you can view the Internet sites matching the 
search criteria very quickly to find sites of interest easily.

The layout of the Table View can be changed by adjusting column sizes with your mouse by using 
the Layout command under the Edit menu item.    The Field Selection icon will allow you to change 
which fields appear to the far left of the screen.

The Page View

If you have alot of information to enter at one time, it is more convenient to use the Page View.    
The Form View moves you over the page to different fields on the form when you are entering 
data, while the Page View has each field in a compact format for quick data entry.    Remember, 
while in the Page View, you need to select the Add icon to start a new page, and the Change icon 
to modify an existing page.    You will be prompted to save your work. 

You can view images at full size in the Page View by selecting the Image icon on the bottom icon 
bar. 



Internet Images

With the maturing of the Internet and the World Wide Web, the visual aspect of the `Net is 
becoming increasingly important.    Site Blaster allows you to place images in the database so that 
you can visually appreciate the qualities of each Web site.

You can use the Form View to view the picture that accompanies an Internet Site within the 
framework of the Screen field, or go to the Page View or Table View to view the image at full size, 
in its own window.    The Image Icon is the one that has a Tree on it along the bottom icon bar.    
Use this to switch from viewing the file names of the images to viewing the images themselves.    
Depress it to view images, but you will want to deselect it to move quickly through the database. 

While you are in the Page View or Table View,    the image window must be closed by double 
clicking on the upper left corner of the image window.    If you do not close the image window, you 
will not be able to return to regular operation of the program.    This is the advantage of the Form 
View - there is nothing to close and the images do not interrupt the normal data access.

.



Collecting Internet Images
See Also:    Saving Internet Images

The Internet Site Blaster can store images that you save from Internet Web sites and display them 
for you at your request.    The first question that will probably come to mind is "How do I get 
images from my favorite Web sites?"    There are actually several answers.

If you use a DOS browser like Lynx, you are limited to downloading images that are available to 
you on the page.    Most inline images will not be able to be downloaded.

If you use Netscape 2.0, you can save images to your hard disk by clicking your right mouse 
button while the mouse is positioned over the image.    A menu will pop-up, allowing you to Save 
the Image.    Select this and the image will be transferred to your computer.

Another source of images is your Windows Web Browser's cache.    It may not look like there are 
image files in your cache, but they usually are there.    This is true of Netscape, Mosaic, and 
America Online Web Browsers.    Sometimes, the image files are erased at the end of the session 
to conserve space.    If this is true, minimize the browser (like Netscape) before you exit the 
program, go to the Netscape\Cache\ directory, and copy the image files (*.jpg, *.gif, etc.) to another 
directory.

One of my favorite methods is to use Paint Shop (tm)    from JASC, which allows you to capture an 
area of the screen while Netscape is online.    Simply select the option under File\Preferences to 
initiate screen capture when the right mouse button is clicked.    You will be prompted to save the 
image in a number of different formats. 

Paint Shop is Shareware, from JASC, and is available on AOL, Compuserve, or the Virtual 
Shareware Library on the Internet.    If you use Paint Shop regularly, you should register the 
program.    Note that Paint Shop is a ~300k zip file, while Paint Shop Pro is ~ 1.7 megabytes.    Only 
Paint Shop is needed.    Paint Shop Pro allows for more image processing features.



Saving Internet Images

The Internet Site Blaster now allows you to store images and screen shots of your favorite 
Internet sites in the database.    These images may be of any of the following types:

BMP - Windows Bitmap File
                GIF - Graphics Interchange File
                JPG - JPEG Image
                PCX - PC Paintbrush
                WMF - Windows Metafile
                IMG - GEM Image File
                PCD - Kodak Photo CD Image
                TGA - Truevision TARGA File
                FIF - Fractal Image Format
                TIF - Tagged Image File

In addition, these non-image file types are supported:

EPS - Encapsulated PostScript File
                TXT - Any ASCII Text File
                WAV - Waveform File (experimental in this version) 

Caution! Not all bitmap (*.bmp) and JPEG (*.jpg) file formats are supported.    The standard 
Windows bitmap file is supported and the standard JPEG format is supported. 

The speed for loading images is best with GIF and PCX files.    Bitmap and JPEG images take 
longer to display.    The speed of your computer, the amount of video memory you have, and 
whether or not you have a graphics accelerator will affect the speed with which images are 
displayed.    On a basic 486SX 25 mHz, with 512 K video RAM, and no accelerator card, image 
displays are very rapid.

How are these files stored and displayed?    It's    easy. 

Simply enter the name of the image file into the field at the bottom of the form called "Screen".    
For instance, you could enter "bigboat.gif" (remember to include the extension, and the full path 
of the image if it is not in the current directory).    The extension (.gif, .jpg, .pcx, .bmp, etc.) tells the 
program how to handle the image.

To display the image files, simply select the Tree icon, or image button, 
 located at the bottom of the screen.    In moments, the image will appear within the frame of the 
Screen field.    The appearance of the image can be altered by adding parameters to the image 
name.

The parameters that can be used are:
  
                              a - Preserve Aspect Ratio 
                                                c - Use Image's Color Palette
                          e - Error Distribution Dither
                                f - 24-bit Image
                                g - Grayscale
                                h - Halftone
                                m - Ordered Dither
                                p - Print (used only with c,e,h, and m)



                                s - Scale to Fit

So, to save an image and use the above parameters, you would enter the name of the image and 
then the parameter letter, separated by a comma.    Suppose you had an image, "galaxy.jpg" that 
you wanted to display entirely within the framework of the Screen field. You would enter    
galaxy.jpg,s and if the aspect ration was to be preserved as well, the image file name entered into 
the field would be galaxy.jpg,as .    Note that there are no spaces between the filename, the 
comma, and the chosen parameter.
 
Text files can be displayed in the same fashion, except that the parameters do not apply.    For 
instance, a text file named "manual.txt" could be entered into the Screen field.    The text file will 
be displayed when the Tree Image icon is depressed.    If you want to work with the text file, simply 
click on the text with your mouse, and you will be in the text editor.    This is handy for keeping 
lengthy notes about a site, or if a site presents alot of text-based information. 

Select the Tree Image icon again so that it is no longer pressed down, and the images will 
disappear, and the image file names will re-appear.    This allows you to move rapidly through the 
database without having to wait for images to load.

If you put the wrong name of an image in the Screen Field, the program will do nothing when you 
press the Image Icon.    This is also the case if you have too few free memory resources to load the 
image.    Generally, you can close one or more of your open applications and the image should be 
able to be displayed afterwards.



Finding Internet Information

One of the most important uses of a database program like this is the ability to search for specific 
information.    When you know specifically what you are searching for, you want to use the Find 
First function:

The key to using the Find First function is to use this on the appropriate indexed field.    If the item 
you are searching for is to be found in the description field, then you must make sure that you 
have the index set to "Description" or the search will produce undesirable results.    If you are 
searching for something in a particular Category field, then "Category" must be set as the index.    
If you have no indexes assigned, this icon will be dimmed and unavailable.    Go to "Indexes" 
under the File menu to add indexes to the database.

When you select the Find First function, you will be asked to fill in box called "Key Lookup" which 
look like this:

The term "Key Lookup" means that the search will be made on a particular indexed field. 

For instance, you might use the Find First function to locate the first instance of "Governmental" 
in the field "Description". The look-up is almost instantaneous no matter what the size of the 
database is.    You will see the particular Internet site that matches the search item presented to 
you.

If you were to search for "Governmental Agencies" , you will notice that there is not an exact 
match, so the search function finds the first match that comes close to the search criteria.    The 
Internet site presented to you may be titled "Government Agency" instead.    The message at the 
bottom of the screen will tell you that an exact match was not found.

When you are not sure of the exact word or terms that you want to search for, then you can use 
the "Group Find" function to find all of the records that are close to your search word or phrase.

This function will not only find the first occurrence of a specified term, but will goup all of the files 
in the database that match the search criteria.    You can then work with these as a subset of the 
whole database.    To return to the use of the whole database you can click on the icon, and it will 
no longer be depressed.    You can then resume working with the entire database as desired. 

There are several important things to know about using the "Group Find" function.



For the "Group Find", you will be asked to fill out a "Group Display" dialog box, like the one 
above.    By simply clicking on the desired field to search on, then the operator (usually the "LIKE" 
operator), then entering a value and selecting "Ok" on the bottom button, you will have 
designated a search formula by which records will be found.

In the example above, Description is clicked on, then "LIKE", and then the word "movie" is 
entered into the value box.      The button at the bottom of the screen will say "Value" on it.    When 
the word "movie" is entered, the Value button is clicked and the button changes to "Ok".    Clicking 
on this button again will start the search.

If you know exactly what you want to find, just enter the word, by itself, like "movie".      However, if 
you want to find all sites that have the word movie, or movies anywhere in the description, then 
the use of the wildcard * is helpful.    By entering the value as *movie* you will find a much broader 
range of sites that have to do with that topic. 

After the first site is found, the search will stop on that particular Internet site.      If you press the 
Fast Forward icon at this time, then the search will continue through the whole database.    Once it 
is finished searching, it is interesting to look at the group of sites collected by going to the Table 
View. It takes a few moments to display the table, but it helps you to see what your search has 
produced.    Again, when you press on the Group Find icon, it will no longer be in the depressed 
position and you will be returned to the entire database.

As tempting as it may be, do not use the other symbols and numbers for your searches as you 
will not get usable results. The equal sign is intended for mathematic functions that are used to 
search on, not applicable in this database.



Entering Internet Information

The Form View is the mode that you will use when you are entering Internet information into the 
database.    Select    the Add icon to begin a new page.    If the page already exists, simply click the 
mouse on the desired field and enter data.    Then press the Enter key to go to the other fields.    
You can enter data into the other fields or just repeatedly press the Enter key until you leave the 
form.    You will be asked if you want to save your information.

If you use the Table View or the Page View to enter information, you must first select the Add icon 
to add a new page, or the Change icon to modify information already present.    When you have 
completed your data entry, you must select the Save icon to save your work.    The Page View is 
helpful at times where you do not want to move up and down the screen to enter information.    
The fields in this view are close together, and can be re-arranged by dragging and dropping them 
with your mouse.

Importing Data:  One of the ways that you can quickly add Internet information to the database is 
to import information.    By selecting "Import" from the File menu, you can add information from a 
specially prepared text file.    First of all, the text file must be pure ASCII, meaning there must be 
no embedded control codes in the file like many word processors insert.    Usually a word 
processor has the ability to save text as plain text or ASCII format.    Text editors generally save 
the text as ASCII text.

The preparation of the text file is simple.    All you have to do is put the Internet Site Description 
and Address on the same line, separated by an "@" sign (without the quotes). The description 
should come first, followed by the address like this:

The Internet Pearls Index@http://www.execpc.com/~wmhogg

If you are including Category and Notes information, then you need to place them in the order 
Description, Address, Category, and Notes, each separated by the "@" symbol.    Each line begins 
a new page, so all information for one site must be on one line. 

When you select "Import" from the file menu, you will be shown a dialog box in which you should 
indicate which file you want to import.    It is best to try this with a few records in one text file, so 
that if there are any mistakes in preparing the file, only a few records will have to be deleted to 
rectify the problem.



Utilities

There are several useful utilities in the Internet Site Blaster.    The most useful Utility is the Export 
command, found under the File Menu.

The Export function allows you to copy Internet information from the program to your hard disk.    
It allows you to select which Internet Sites to export by entering a search term or phrase, such as 
"game".    The program then looks through the database and selects all of the sites that have 
"game" in their Description field, and copies them to a file you specify on your hard disk, such as 
"game.txt".    Just as with other search functions in this program, the results are usually better 
when you add a wildcard symbol, *, to each end of the word or phrase.    Entering " *game* " , 
instead of just "game", will find the term "game" no matter where it appears in the Description 
field. 

The resulting text file will contain entries such as this:

3-D/Virtual Reality Games@http://www.cts.com/~pcs/3d.htm
Hobbies, and Games@http://tezcat.com/web/hobbies.html

This is the format that the program's utilities use to convert the Internet information into Netscape 
Bookmarks or Mosaic Hotlists.    The Export function lets you select information to copy from Site 
Blaster based on keywords.    Try using the Export function with search terms such as *HTML*, 
*Game*, *Book*, or *Fun*.

Certain browsers do not allow direct pasting into their program from the Windows Clipboard, such 
as Netscape.    Instead, you have to import the site information into Netscape from a bookmark file. 
This bookmark file has to be in a certain format to be able to be imported.    Site Blaster will format 
your file for you by using the "Create Bookmarks" function under the Utility section of the Site 
Blaster menu.

This utility looks for a file called "ouput.log" that contains information in the format of "Site 
Description" @ "Site address", such as this:

Disney Main Site@http://www.disney.com
Compaq Computer@http://www.compaq.com

Note that each site is listed on a single line.

Site Blaster will create this file for you with the Export command under the File menu.    By using 
the Export Filter, you can select a topic, such as `HTML' and all the files that match that 
description will be exported to a file on your hard drive.    These files will be in the format "Site 
Description" @ "Site address", ready for use by the Create Bookmark function. 

Once you have completed the file preparation, the Create Bookmark function will look for the 
target file with the name "output.log".    If you have not renamed the file to "output.log" yet, then 
you will be prompted to do so.    A file function dialog box will pop up that will allow you to rename 
the file from within Site Blaster.

The file created can be imported into the Netscape Navigator, using the Menu under the 
Bookmarks section of the Browser. The file produced will be named "bmark.htm".    This file, of 
course, can be renamed or edited.

In this same fashion, the "Create Hotlists" utility will create Mosaic Hotlists out of selected 
Internet information that can be opened and used from within the Hotlist section of the Mosaic 
Browser.    The file produced will be called "blaster.hot", which can be renamed or edited.



A very helpful utility is the built-in Text Editor that can be selected from the menu or by pressing 
the [F8] function key. 

From the text editor you can open text files that contain Internet information that you want to add 
to the database.    You can also cut-and-paste information from the database to the text editor and 
save this in a text file.

When using the cut and paste method of adding information to a text file, you select the 
information by holding the left mouse key down and dragging it across the desired text in the 
database field.    This will mark the text to be copied.    Then go to the Edit menu item and select 
"Copy".    The information is then saved to the clipboard for you to copy into the text editor or 
other Windows applications, such as your WWW browser, if it allows. 

If you are pasting into the text editor, the next step is to set the focus to the text editor by clicking 
the mouse within the text editor window, and then press the keys CTRL-V to paste the information 
from the clipboard. 

The Table View is particularly helpful here because you can highlight all of the fields for one site 
on a single line and then copy the information to the clipboard from all of the fields at once.    You 
highlight a site in the Table View by using the Up and Down arrow keys to position the bar over 
the site you want to copy.    Then go to the Edit Menu and select "Copy".

The other utilities include functions to tell you about the Status of the file and of the system.    You 
can close the window after the report is displayed by double-clicking on the window control in the 
upper left corner of the report. 

You can also perform displays of any directory you choose as well as perform common file 
functions such as copy, rename, display text files, etc.



Menu Command Summary

FILE:

Update Database -    Add new information, provided by SoloTech, to your Internet Site Blaster 
database.

Indexes - Allows you to add or remove field indexes.

Print - Print current page info.

Print Setup - Choose printer options.

Page Setup - Specify page format.

Import - Import Ascii-delimited file into database.

Export - Export Site Blaster information to a Text file.

Exit - Quit program.

EDIT:

Cut - Remove marked information from a field and place it on the Windows clipboard.

Copy - Copy marked information from a field and place it on the Windows clipboard.

Paste - Place the contents of the Windows clipboard at the cursor position in a field or the text 
editor.

Delete - Remove marked text permanently.

Layout - Change the width of the first field in the Table View.    Use the mouse to adjust the width 
and then click.

VIEW:

Table - Show data in Table format.

Form - Show data in Form format.    This is the default view.

Page - Show data in Page format.

Field Selection -    Change the order of the Fields in the Table or Page view.

DATA:

Add - Add a new blank page to enter new Internet information.

Change - Modify the information on the present page.

Save - Save the present page to file.



Remove - Delete the present (Current) record, or a Group of records matching a specified set of 
criteria. You will need to fill out the Filter Dialog box to specify which records to delete.    The 
procedure is the same as in Group Find, except that these records will be removed, instead of 
grouped together.

UTILITIES:

Text Editor - Edit text files from within the program.    Paste Internet information from the clipboard 
into the Text Editor.

Create Bookmarks - Select Internet information which will be converted into Netscape(tm) 
Bookmarks for importing into Netscape Navigator.

Create Hotlists - Select Internet information which will be converted into Mosaic (tm) Hotlists for 
use with the Mosaic Web Browser.

Status - Gives information on the status of the the file and on the system.

Directory - View any directory from within the program.

Files - Perform file operations from with the program.

OPTIONS:

Icon Bar - Set the position of the Icon Bar.

Status Bar - Toggle the Status Bar on and off.

Selection Bar - Set the position of the Selection Bar

System - Change or set the working directory.    The other settings should not be modified.

Display - Set the display font size.    The other settings should not be modified.

.



Registration Benefits

Registration Benefits

 1. Put the power of the Internet at your    fingertips. Search over 30,000 Internet    Sites in the 
Registered database with    descriptions and addresses, showing how these    sites can be 
reached. By using the built-in Utilities or the Export command,    you can copy information    from 
Site Blaster for use with your favorite WWW browser.    Create Netscape Bookmarks and Mosaic 
Hotlists from within your Site Blaster program.

2. Included in the 30,000 Internet Sites will be many screen shots and images from your favorite 
WWW sites.    With the    images in front of you, it is easy to decide where you want to go next on 
the Internet.

3. Receive "The Internet Primer", a Windows Help file that bursts with useful information on 
numerous Internet topics including Searching the Internet, Internet Starting Points, Using HTML, 
Designing Web Pages, Accessing Free-Nets, Software Libraries, Internet Tutorials and Guides, 
Internet Access    Providers, Helpful Computer Magazines on the Internet, What's New, What's 
Cool, What's Hot, Corporate Computing, and a Complete Listing of the Virtual Libraries available 
on the Internet. 

4. Receive the "SoloTech Internet WinBook" - a Windows Help file with hundreds of sites and their 
addresses compiled by category.    Almost every conceivable topic has been included in this 
valuable guide.

 5. Only the Registered version of Internet Site Blaster is continually edited and updated. To have 
the newest links and the latest updated site information, you'll need the Registered version. As the 
web grows, the sites are becoming more interesting and more entertaining. Only the Registered 
version will give you info on what is currently hot on the Internet.
 
 6. Only Registered users will be able to obtain regular updates to the Internet database.
 
 Even though the Registered database is extensive,    it requires little disk space and maintains 
blazing search speed. 

 Here is a partial list of the topics included in
 the Registered Version:

Advertising
Aeronautics
AIDS
Animal
Archeology
Architecture
Art
Astronomy
Australia
Australian Government
Automobiles
Aviation
Bible
Boating
Books
Botany



Browsers
Bulletin Board Systems
Business and Finance
Buying and Selling
California
Canada
Canada Government Resources
CDC - Centers for Disease Control
Census
Chemistry
Christian
Chronic Fatigue Syndrome
Classified Ads
Comics and Cartoons
Commerce
Computers: Hardware
Computers: Shareware
Computers: Social
Computers: Software
Consumer Services
Crafts
CyberThings
Dance
Diabetes
Disability
Disney
Drama
Drugs
Ecology
Economics
Education
Electronics
Environment
Europe
FDA
Federal Government
Football
Fun
Future Technology
Games
Gardening
Geography
Geology
Government
Government Agencies
Government Research Institutes
Graphics
Health
History
Hot/Cool Sites
HTML
Humor
Images
Internet Indexes
Israel
Japan



Jewish Culture and Religion
Jobs
Journalism Resources
Judicial System
K12
Language Studies
Law
Legislation
Libraries
Literature
Lyme Disease
Magazines
Mathematics
MBA
Medicine
Military
Movies
MUDs
Music
NanoTechnology
NASA
NATO
Navy
New York
News
Newsletter
News Magazine
Newt Gingrich
NIH
Pets
Pharmaceuticals
Photography
Physics
Pictures
Poetry
Politics
Quotations
Recreation
Reference: Dictionaries
Reference: Thesaurus
Romance
Russia
Science Fiction
Software Repositories
Sports
Star Trek
State Governments
Statistics
Technology
Telecommunications
Telephones
Television
Texas
The Presidency
Travel
TV



U.S. House of Representatives
U.S. Senate
UFO
UK
USA
Video Games
Virtual Reality
Weather
What's New

Thanks for trying the Internet Site Blaster!



Ordering

Simply print out and complete the appropriate form below:

Order Form - UK and Europe

Order Form -    Other



Order Form - UK and Europe

For U.K. and Europe:
  

                                The Internet Site Blaster v3.0
                                    Copyright (c) 1995-96 by William Hogg M.D.
                                              SoloTech Software

                                              ** ORDER FORM **

To register The Internet Site Blaster and receive the registered version of The Internet Site Blaster, 
with a complete 30,000 Internet Site Database, simply PRINT OUT this order form, complete it, and 
mail with your cheque or money order to:                                                                              (credit card orders - 
see below)

  
The Thompson Partnership
Lion Buildings
Market Place
Uttoxeter
Staffs ST14 8HZ
United Kingdom

Tel: 01889 564 601
Fax: 01889 563 219
BBS: 01889 568 625

 The Internet Site Blaster          ...................................    £ 24.95
 VAT @ 17.5% (all EU countries) .............................    £      4.37 
                                              Shipping .........................................    £      3.00

                                              Total Due.........................................    £    32.32

                                                                                      * * * * * * * *

Educational Discount for Schools and Universities Available. Send E-mail to sales@ttp.co.uk for 
further information.

 Method of Payment: Cheque (Drawn on a UK Bank) / EuroCheque
 For Credit Card Orders: See Below.

                          Name:    ___________________________________________________

                    Company:    ___________________________________________________

                    Address:    ___________________________________________________

    City, Post Code:    ___________________________________________________

                Disk size:    3 1/2" ___    1.44 MB

                                                    * * *
        Credit Card Orders: 



  
        The Thompson Partnership is able to take credit card orders over    the phone or by FAX.    
Simply call us on 01889 564 601 with your credit card handy.    We need to know the number and 
the expiry date.    We can take Access, Mastercharge, Visa, Amex and Diners Club.

        Alternatively FAX us this form with your credit card details
        filled in below:

Card Number: ______________________________

        Expiry: ___/___



Order Form -    Other
For U.S. Orders and orders outside Europe:

                                    The Internet Site Blaster v3.0
                    Copyright (c) 1995-96 by William Hogg M.D.
                                                SoloTech Software
                                                ** ORDER FORM **

To register The Internet Site Blaster and receive the registered version of    The Internet Site 
Blaster, with a complete 30,000 Internet Site Database, simply PRINT OUT this order form, 
complete it, and mail with your check or money order to:                                                                        (credit 
card orders - see below)

                                            William E. Hogg M.D.
                                              SoloTech Software
                                                P.O. Box 44102
                                            Madison, WI 53744-4102

 The Internet Site Blaster          ...............................................    $38.00

                                          U.S. Shipping and Handling............................        5.00

                                              Total Due......................................................    $43.00

 Wisconsin residents (only) add 5.5% sales tax (38 x .055)....    ($ 2.09)

Check or Money Order (U.S. Funds) Amount ......................... $_____

                                                                                * * * * * * * *

Educational Discount for Schools and Universities Available. Send E-mail to 
wmhogg@execpc.com for further information.

 Method of Payment: Checks or Money Orders Accepted - U.S Funds Only.
 
For Credit Card Orders: See Below.
 Shipping: U.S.- $5.00, Canada and Mexico - $7.00, International $10.00.

                          Name:    ___________________________________________________

                    Company:    ___________________________________________________

                    Address:    ___________________________________________________

 City, State, Zip:    ___________________________________________________

                Disk size:    3 1/2" ___    1.44 MB

                                                              * * *
        Credit Card Orders: For Visa or MasterCard orders there is an order line which can process 
ORDERS ONLY. [No support is provided at this number and questions about the software will be 
unanswered.]

        If you have a valid Visa or MasterCard, you can call the order line    at NorthStar Solutions from 



10 AM to 10 PM (Eastern Standard Time) at:

                                    1-800-699-6395    or    1-803-699-6395

        Have your credit card information ready with number and expiration date.    Tell the person 
taking your order that you want to register    the "SoloTech Internet Site Blaster". 

        Regardless of the version number that you specify, you will receive the most recent update to 
the program.      While we will make every effort to mail your order promptly, please allow 14 days 
for delivery.

 WEH






